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ABSTRACT

MikroTik operating system is designed for a network router. These functions include IP
Addressing, Firewall & Nat, Routing, Bandwidth Limiter, Point to Point Tunneling
Protocol, DNS server, DHCP server, Hotspot, and many other features. It is very useful
for our daily life. In this sector we will know about Cisco, MikroTik, Cabling, Linux
System etc. Network devices are connected to computers, peripherals, even LOT devices.
Switches, routers and wireless access points are the essential networking basic. Through
them device connected to network can communicate with one computer to another
computer and with other networks, like the internet. Now today a large number of people
all over the world usage internet technology with their dally life. So, the networking is so
much important fact right now. Now-a-days every single people, business and e-
commerce, every work station is fully depending on software-based communication and
internet technology. That is the reason it’s extremely valuable to anchor the system.
Computer system and peripheral are connected to form a network. They provide various
advantages, for Example-Instant messaging, parallel computing, video conference,
interaction with other users using dynamic web pages, sharing information by using
internet or web.
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CHAPTER 1
Introduction

1.1 Introduction:

A network device is connecting to computer, peripherals, even LOT devices. Routers,
switches and wireless access points are the essential networking basics. | choose this
internship because | wanted to benefit from the experience. Through them device

connected to network can communicate with one computer to another computer.

1.2 Motivation:

I am currently pursuing in the final semester of my Bachelor Degree program in CSE. |
choose my internship at Daffodil Online Limited (DOL) because | discovered that the
Daffodil Online limited has overcome every customer satisfaction & services because
of their excellent reputation. Daffodil Online Limited (DOL) is now a well-known and
reputed Internet Service Provider (ISP) in Bangladesh. | think that I can successfully
prove my experience by the help of Daffodil Online Limited.

1.3 Objectives:
Now in the modern world “Basic MIKRO TIK & LINUX” is a very generic term. The

internship program is making me as a compatible one in the job market. Temporary job
in software engineering is a stage to give better work encounter when an understudy is
still in school, to equivalent occupation aptitude with scholarly preparing, and to assist
understudy with preparing the change from school to work.

e Install Mikro Tik and perform network configuration.

e Install Linux for server administration and maintained hardware Equipment.
Perform user and group administration.
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1.4 Introduction of Company:

Daffodil Online Ltd is a top-rated Internet Service Provider (ISP) in Bangladesh and
furthermore the most experienced and prominent organization in the ICT field where
they are essential business morals is Long Term Relationship with their clients. They
are exceptionally future. In the time of 2002 they are begun their excursion. Since the
earlier years, they expounded grateful of what they have picked up, and furthermore
more enthusiastic about their viewpoint for a similarly cheerful their exercises and

administration office following to the client’s proposal and thinking about need of time.
[2]

1.5 Layout of the Report:

In this report | shown the introduction, motivation, objective, introduction of company,
introduction about my internship organization, and also about the company, company
product for marketing and organization structure of the company.

After that | show my internship dally task with activities events and project task and
activities.

At last I described Conclusion & Discussion, Future Career & Scope, and also discussed
Future Scopes of the platform MikroTik and Linux.
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CHAPTER 2
Organization

2.1 Introduction:

The internship enterprise where | have taken my Training is Daffodil Online Ltd.
Daffodil Online Ltd. (DOL) is proud to be one of the promoters and oldest ISP/ASPs in
Bangladesh and providing one stop integrated ICT services and solution since July 2002.
During. the past years, they extended their operation and service portfolio according to

the customer’s recommendation and considering demands of time.

2.2 Product for Marketing:

Daffodil Online Ltd. prides itself as one of the main across the nation Internet Service
Provider (ISP) in Bangladesh. They are the most experienced and most seasoned
Organization in the ICT field where they are fundamental business morals is long Term
Relationship with their clients. As they take a gander at the development throughout the
Decade since our origin, they are to a great degree glad for what we have accomplished
And considerably more amped up for our viewpoint for a similarly encouraging future.
Daffodil Online Ltd likewise gives distinctive IT Services and professional Training

Administrations. These are given underneath

The Daffodil Online Ltd provides us particular IT Based Professional Training services.
These are:

* ISP support.

» IT Security protection.

* Web Hosting & Domain Registration.

» Corporate level Internet Solution.

» IT based Professional Courses & Training.

» Open Source application solution.

*  Web site Development.

© Daffodil International University 3



2.3 Organizational Structure of Daffodil Online Limited:

Chairman

Managing Director

General Manager

CEO
Manager
Deputy Manager
Sr. Assistance Manager
Assistance Manager
Senior Officer
Officer

Officer Staff

Figure 2.3.1.0: Organization of Daffodil Online Limited
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CHAPTER 3
Internship Roles & Responsibilities

3.1 Daily Task and Activities:
O Month - 1: In the first month of my internship at daffodil online limited I have
learned and performed the following tasks:

About IP address.
Introduction of MikroTik.
PC based Installation of MikroTik Router OS using VMware.

0
0
0
0 Configure Mikro-Tik Router with Commands.
0 How to configure ISP link.

0

How to configure your LAN Network.

O Month - 2: In this month | have learned and performed the following tasks:
Bandwidth Control in different ways.
Bridge mode configure.

Firewall and NAT Configuration.

s Y s N s N s |

Network Security.

O Month - 3: In this month of | have learned and performed the following tasks:
Introduction of LINUX.

Installation of Linux CentOS 6.4.

Managing User Accounts and passwords.

Basic Linux Commands.

File and Directory Making and Control.

O O O O O &4

Work effectively on the Unix Command Line and Run level concept.

O Month — 4: In this month of my internship at daffodil online limited | have learned

and performed the following tasks:

© Daffodil International University 5



File and Directory Permissions.
User and Group Add and Modification.
Ownership, Group and User Permission.

ACL Permission Configuration.

O Oao O O OO

Linux System Administration.

3.2 Events and Activities:

Preparing is critical for temporary position is the main stage, when an understudy faces
some issue amid entry level position, at that point it is obligatory to give preparing to
address the issue. Issue has been identified& preparing can be tackling it. Preparing can
be depicted aptitudes, ideas, enhanced execution in temporary position condition. In this
internship on daffodil online limited | have learned and performed the following tasks:

About IP address for all class of IP with Subnet.
Mikro-Tik Router and Configuration.
Learning & understanding About Network Components.

Install and Configuration in Linux, step by step full describe with figure.

O O O O O

Linux System Administration.

3.3 Project Task and Activities:

3.3.1 About IP address:

An Internet Protocol address (IP address) is a numerical name pointed to every gadget
associated with a PC organizes that uses the Internet Protocol for correspondence. An
IP address serves two main capacities: host or system interface ID and area tending to.
Web Protocol form 4 (IPv4) characterizes an IP address as a 32-bit number. Be that as
it may, in light of the development of the Internet and the exhaustion of accessible IPv4
addresses, another adaptation of IP (IPv6), utilizing 128 bits for the IP address, was
created in 1995, and institutionalized as RFC 2460 out of 1998. IPv6 organization has
been continuous since the mid-2000s. IP addresses are normally composed and shown
in intelligible documentations, for example, 172.16.254.1 in IPv4, and
2001:0b8:0:1234:0:567:8:1 in IPv6. !

© Daffodil International University 6



3.3.2 Introduction of MikroTik:
MikroTik is a network-based equipment manufacturing company. MikroTik was
founded by Latvia in 1996 to develop ISP System with Router & Wireless Devices. !

3.3.3 PC based Installation of MikroTik Router OS using VMware:
Requirement Items:

* VMware Workstation Application.

* Mikro-Tik Router OS ISO image file.

*  Winbox.

Now | show the Install Guideline Step by Step:

Step 1: At first install VMware application and open it, then click on File>New Virtual

Machine>Typical>Next.

OB ®

mikrotik-6.22 VMware winbox
Workstati...

&) B23 - VMware Workstation

File Edit View VM Tabs Help - L = New Vir A wi 1
'3 New Virtual Machine... Ctri+N
5 NewWindow Welcome to the New Virtual
Open.. Ctrl+0 Machine Wizard
Scan for Virtual Machines
Close Tab CUl+W by Sodimackine B e B ComOration 45 yon W
[ Connectto Server. Ctri+L  ftual machine settings 1,
4% Virtualize a Physical Machine.
81 Map Virtual Disks.. Iy 512 MB
Exit sors 1
[[~ & Hard Disk (1DE) 868
CD/DVD (IDE) Using file EAMikr
¥ Network Adapter Custom (VMnet0) \,
¥& Network Adapter 2 Custom (VMnet8)
&) Sound Card Auto detect k
& Display Auto detect — h e P :

Figure 3.3.3.1: VMware welcome screen

Step 2: Now Select on the Installer disk image file(iso) and choose the iso image file
and then click on Next. After that create a virtual machine name and also choose
location where the machine is Install, then click Next. Now configure the Hardware

requirement how we have need.

© Daffodil International University 7



New Virtual Machine Wizard X

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
system. How will you install the guest operating system?

Install from:
O mnstaller disc:

~ CD Drive (H:)

(@ Installer disc image file (iso):
E:\MikroTik\MikroTik\mikrotik-6.22.is0

3\, Could not detect which operating system is i this disc image.
You will need to specify which operating system will be installed.

(O 1 will install the operating system later.

The virtual machine will be created with a blank hard disk.

Help < Back Next > Cancel

New Virtual Machine Wizard x

Name the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

| Testo2]

Location:

C:\Users\Mahmud\Documents\Virtual Machines\Test02 Browse...

The default location can be changed at Edit > Preferences.

< Back

Cancel

Figure 3.3.3.2: VMware Configuration for MikroTik OS

Step 3: Now click on the “Power on the virtual machine” and then show a welcome

screen where click “a” for select all and then press “I” to install. Then press “n” to do

not keep configuration and *“y” to continue. After install complete show a login screen,

where press MikroTik Login: admin and password: admin then enter.

Figure 3.3.3.3: MikroTik OS Installation

Uelcore to MikroTik Router Software installation

roTik

ikroTik Login: admin

sword:

© Daffodil International University 8



3.3.4 MikroTik Router Configuration:

,/fln;;rnet

Public Networl:
10.5.8.0/24 =9
HUB
. . Gateway
= 10.5.8.1

64bps  Interface: Public
IP Address: 10.5.8.104

Interface: Local

Logal Nty 128kbps  IP Address: 192.168.0.254

192.168.0.0/24 HUB l

‘
Server Laptop
192.168.0.1 - 192.168.0.3
Worlstation

192.168.0.2
Figure 3.3.4.1: Network Topology of MikroTik

At first download Winbox and router os 1ISO image file, after that install router os in
vmware and run winbox, now click on the Mac address type “admin” in login window

and do not need to give user Password. !

© admin@00:0C:29:96:E4:D7 (MikroTik) - WinBox v6.22 on x86 (x86) = m] X
Session Settings Dashboard
‘ o ‘ 4 ‘ | Safe Mode SESS|on:]O0.0C.29;96:E4;D7 | Nl

Ay Quick Set

1 CAPsMAN

s Interfaces

5 Wireless Temminal B

24 Bridge =

% PPP

® Mash 00 104 HRH TTITTTIITIT KK

. WM e KKK TTTTTTTITIT KRR

&P M| eed e e ITT ERK KKK RRRRRR 000000 bud IIT KKK KKK

Pv6 | we v e ITT  ERRKK RRR RRR 000 000 T IIT  KKEKK

= o M#4 IIT KKK KKK RRRRER 000 000 TTT IIT KKK KKK

" MPLS N oew Me4 IIT KKK KKK RRR RRR 000000 TTT IIT KKK KRK

# Routing B

MikroTik Router0S 6.22 (c) 1999-2014 http: //www.mikrotik.con/
{8 System P
& Queues
. ROUTER HAS NO SOFTWARE KEY
|| Files
Log You have 23h32m to configure the router to bs remotely accessible,

= - and to enter the key by pasting it in a Telnet window or in Winbox.

5 Radius Turn off the device to stop the timer.

x Tools See www.mikrotik.com/key for more details.

i New Terminal Current installation "software ID": 3RBP-JIKQ

ISDN Channels |Please press "Enter” to continue!
ping 192.168.50.1

E§ kM [admin@MikrcTik] > ping 192.168.5§ T
_ Make Supoutif T

am | . [ >
& New WinBox 3|1ij

Figure 3.3.4.2: Winbox Dashboard
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3.3.5 Static-1P Configuration in MikroTik Router:

At first Click on “Interface” to show and define our port such as LAN, MAN, WAN.

© 20min@00:0C:29:96:£4:D7 (MikroTik) - WinBox v6.22 on x86 (x86) = o X
Session Settings Dashboard
©|[cs] | safeMode | Session|000C2996E4D7

A& Quick Set
1 CAPsMAN
= Interfaces
1 Wireless

General | Ethemet  Status  Traffic

Name: fi I | Cancel
Type: |Ethemet ] Aol
MTU: (1500 _ ] =
emu| ] o
Max L2 MTU: | ] Taich
TSI;:‘(’::::“::I oL MAC Address: (000C29.96E4.CD . Cable Test
FLKVWM Ebid ARP: |enabled B Blink
j Make Supoutrif Reset MAC Addres
@ Manual

@ New WinBox

Figure 3.3.5.1: Interface

Now, click on “IP>Address>Add IP on Address and Network>Apply OK”.

[=] E3

| [Address |
17216 | Address: [[EREEZE | oK
= Network: 192168500 |« Cancel
Interface: [éﬂTev1 WAN ]l i ] Apply
Disable
Comment
Copy
Remove
|en§5!;d

[Ziems (1 selected)
Figure 3.3.5.2: IP Addressing

Next, click “IP>DNS>Add Server IP address>Apply OK”.

DNS Settings

Servers: 203.190.10.252 | 0K
203.190.10.253 | | Cancel

Dynamic Servers: | |——APP'V N
"] Allow Remote Requests

Max UDP Packet Size: 4096
Cache Size: 2048 KiB
Cache Used: 8 J

Figure 3.3.5.3: DNS Server

© Daffodil International University 10



After that click on “IP>Firewall>Add+>Action>Select=masquerade>Apply Ok”.

") (’i ‘ fgé@de | Session:|00:0C:29:96:E4-D7

A5 Quick Set New NAT Rule B

1 ICAI:f:MAN Advanced Extra Action | Statistics | .| | |

i Interfaces

5 Wireless Action: |accept H ¥ | I Cancel |

= accept A

#4 Bridge add dstto address list I eel |

=g PPP add src to address list Disable

s Madh R :i Log Prefix: | st nat | l I
° irewal ! jump I Comment I

e | CErr— o |t

L ”

~ MPLS s (=] ] N [ Remove || [[at
¢ s passthroug

# Routing o | | [Actio redirect I Reset Counters I SENEE Hites

i System P 's‘:“r"n': | ResetAll Counters |

& Queues src-nat

Files |

Figure 3.3.5.4: Firewall

Now click “IP>Routs>Add+ New Route=Dst. Address + Gateway>Apply OK”.

A Quick Set
i CAPsMAN
m Interfaces
i Wireless New Route
&4 Bridge General ‘Ahibma ‘
3 PPP :
@2 Mesh Dst Address: |[IXU{¢R0)
P N Gateway: |192.168.50.1 [=]]
ls! IPvE r :
.’ MPLS | | Check Gateway: I )
#2 Routing ¥ Type: [unicast
5 System I
& Queues Distance: I
|| Files Scope: [30
1 Log Target Scope: [10
B Radius ;

: Routing Mark: ‘
X Tools I
@ New Terminal Pref Source: |

ISDN Channels
= AR

Figure 3.3.5.5: IP Routing
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After process are complete then check the instruction by “New Terminal>Terminal=
ping (IP)>OK”.

| Safe Mode | Session:|4C:5E:0C:2B:84:83 BE
4% Quick Set
i CAPsMAN
= Interfaces
I Wireless Terminal
% Bridge TRINSB, Boogomee WD (@) P B
2 PPP R TR s W
5 = VAFAVANANE | <L btbL Q77 11 <
= Swich VOVLIDNALL A/ ILILIN (e)2013
°2 Mesh MikroTik RouterOS 6.41.1 (c) 1999-2018 http://www.mikrotik.com
gl P P [21 Gives the list of available commands [ ]
% MPLS I |command [2] Gives help on the command and list of arguments
£ Rouhng § [Tab] Completes the command/word. If the input is ambiguous,
5 System ¥ a second [Tab] gives possible options
’ Queues / Move up to base level
[ Files ey Move up one level
Lo /command Use command at the base level
el Q» [admin@MikroTik] > ping 192.168.50.1
M Radius SEQ HOST SIZE TTL TIME STATUS
XTOOB P 0 192.168.50.1 56 €4 Oms
- 1 192.168.50.1 56 €4 Oms
(@ New Terminal 2 192.168.50.1 56 64 Oms
®/LCD 3 192.168.50.1 56 64 Oms
4 192.1€8.50.1 56 €4 Oms
74 MetaROUTER 5 192.169.50.1 56 64 Oms L
- i i -
foFion TE—

Figure 3.3.5.6: IP Ping

Final Step, now connect pc with static IP click on “PC Setting>Network>Change
adapter setting>Ethernet>Properties>IPv4=Use your static IP address, gateway,
subnet mask and DNS server>Apply OK”. [6]

(™ Bluetooth Network ./ Ethemet = VirtualBox Host-Only
Connection Network S Network
x

Not connected & Killer £2500 Gigabit Ether.. @ Disabled
( VMware Network Adapter ™/ VMware Network Adapter Wi-Fi
E, VMnet1 VMnet8 Not connected
@ Disabled ( R f Killer Wireless-n/a/ac 1535
e Sohamat Coatue 2 "
@ Ethemet Properties X
Networking ' Shating
Internet Protocol Version 4 (TCP/IPv4) Properties X
General
TH  You can get IP settings assigned automatically if your network
supports this capability. Otherwise, you need to ask your network
N administrator for the appropriate IP settings.
8
8 (O Obtain an 1P address automatically
’ ; (@ Use the following IP address:
L[] e
| |9 subnetmask: 255.255.255. 0
P LRt D
octot aevor:

L

I

Obtain DNS server address automatically
(@ Use the following DNS server addresses

Preferred DNS server: 203 .190 . 10 .252

Alternate DNS server: (8 588 .8 |

=

[[Jvalidate settings upon extt i

o ][ et

Figure 3.3.5.7: TCP/IPv4 Configuration
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3.3.6 At first click on “IP>DHCP Server>DHCP Setup= select needed server
interface>Next>DHCP Address Space= example (172.160.20.0/24)>Next>Gateway
DHCP Network= example (172.160.20.1)>Next>Address to Give Out>Next>DNS

Server>Next>Lease Time”.

6 (DHCP) Dynamic Routing Configuration with MikroTik:

“1g Mesh
s IP eIve:

< MPLS DHCP ‘Nemonks Leases Options OptionSets Alerts
# Houlng [=] [=][x] _] [ pHeP Conﬁg JfDHCP ,s,e.‘p, |
& Syl | Name 7 Interface I
& Queues ‘
Files

s ‘

4 Radius DHCP Server Interface: wlanl N It
X Tools emerl -WAN
@ New Terminal
i LCD
#4 MetaROUTER
#5 Partition zﬂ::g

- Make Supout rif ether8
& Manual - - etherd | - -
@ New WinBox e - :”'7”0 k
B Bt _

Selact network for DHCP addresses

DHCP Address Space: |[EE i |

DHCF Setup
Selact gateway for given network

1

Gateway for DHCP Network: [ 72

| Back ” ﬁ Cancel

L onck || Mg | [ cancer]

Addresses to Give Out [ _

JHC p
Select pool of ip addresses given out by DHCP server

| Back ll N?s:_' [ Cancel]

DNS Servers: [203 19010 252
1203.190.10.253 |

Lease Time: {24:00:00

Selectlease ime

[ Back " Nelt HCancel]

Figure 3.3.6.1: Dyna

mic (DHCP) Configuration
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Now Restart winbox and reconnect ethernet port IPv4 into automatic from pc then click
from winbox “IP>ARP= where show ARP list”. [¢]

ADY

ARP List

|IP Address  / |MAC Address Interface v
DC 9172160202 4CCCOHADF889A etherd-LAN
D 917216020254 4C.CC6ADF889A etherd-LAN
DC ©19216850.1 D4.CAGD:81:6D56 etherl-WAN

3items
¥ e
@ Ethernet Status X |
i
Network Connection Details X
Network Connection Details:
Property Value
Connection-specific DNS S...
Description Killer E2500 Gigabit Ethernet Controller
Physical Address 4C-CC-6A-DF-88-9A
DHCP Enabled Yes
IPv4 Address 172.160.20 254
IPv4 Subnet Mask 2552552550
Lease Obtained Tuesday. October 9. 2018 457:53 PM
Lease Expires Wednesday. October 10, 2018 45754 PM
|IPv4 Default Gateway 172.160.20.1
IPv4 DHCP Server 172.160.201
IPv4 DNS Servers 203.190.10.252
203.190.10.253
IPv4 WINS Server
NetBIOS over Tcpip Enabl.. Yes
Link-local IPv6 Address fe80:5908:a%¢b:8edb:8f1%2
IPv6 Default Gateway
IPv6 DNS Server

Figure 3.3.6.2: ARP for Dynamic (DHCP) Configuration
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3.3.7 Bridge Configuration with MikroTik:

“Bridge>click + Add>Bridge n= 1,2,3.... > +name fill up>Apply Ok”

Select Ports:

v
v
v
v
v

“IP>DHCP server >DHCP setup>Next>Apply Ok”.

o

ether2

ether3 LAN
ether6 MAN
ether9

wlanl

(0] x| Sofe Mode | [D4CASD 86000 LI
A Ok Set
1 CAPSMAN
- irtedaces
1 Wiess
34 oe
W PPe Genersl | STP Suatus Traffic oK
= Swich
Name ST Cancel
3 Mesh o B
wr | ovoe |Pots Faem NAT Homs .:'U* |
2 WL : | (][] [¥] [ setmgn mm‘ Disable =
3 Hakg [ IName ~ Type = Commert | b Packet p/s) |FP Tx IR2
. System R $dbadgel Brdge L2NTY: 0 Obps
e i Copy
& Oueves MAC Address
i Fies ARP. |enabled 3
Log = = : Torch
= ARP Timeout i
B Radun ¢
v
X Toos Admn. MAC Address: |
8 New Temnal
L Jt=]
#4 MetaROUTER
& Pattion

Figure 3.3.7.1: Create Bridge name

SIR(<1H0 4]

 |Badge
brdge1

o, [EE
I
0r System I Swan]
& Cueves
o Fles
1 Leg
S Radus
X Tooks
W New Teminal
™o
5 MetaROUTER
@ Parttion
| Make Supout f 1
@ Marual e J
e e
-

Figure 3.3.7.2: WAN configure of Bridge port
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& Quick Set B
1 CAPSMAN Bidge Pots |Fiters NAT Hosts
1 interfaces +* 7
L Wireless intedace Brdge Priorty ... |Path Cost | Horizon |Role Root Pat v
32 Bidge | Hhethert saddam 80 10 disabled pot
o0 | ethers saddam 80 10 disabled port
w3 PP | Adethers saddam 80 10 dsabled pot
= Swich | a7 bdge1 80 10 dsabled pot
Mesh DHCP Server [=1 3
4P DHCP | Networks Leases Options  Option Sets  Alerts
MPLS + V| | DHCP Config || DHCP Setup
o Paika Name Itedace Relay| Add AR -
; System dhep! bidge1 | DHCP Setup no
dhep2 unknown | o
B ames dncp? unknown Setup has completed successfuly | no
(] Files dhopd saddam no
tog
A, Radus
% Tools
B New Teminal
® L0
#4 MetaROUTER
¥ Partion
& Make Supout of e
@ Manual

Figure 3.3.7.3: DHCP Setup configure

3.3.8 Site Blocking Configuration:

Site Blocking Rules: “Such as YouTube and Facebook”

Regexp>

A, + (youtube.com)

*$,

N, + (facebook.com).*$

This is the rule for block site, we need to apply these rules.

“IP>IP address>IP assign 172.10.0/24>Firewall>New firewall 7 Protocol>YouTube
name assign>Apply Ok>New firewall rule>General>source address IP assign
172.10.0/24>Apply Ok”. 6]

O Step 1:

i Ouick Set
L CAPsMAN
- rtedaces

s Bidge
we PP
o= Swich

P

MPLS

4 Routng
2 System

) Fles

2 Racus
X Tools
B New Temnal
L gt
#4 MetaROUTER
& Pattion

+ Make Supout of
@ Mol

+ 7

Address Network iterdace

17250101724 17250100  saddam

£192168.50.24/24 192168500  ether2
Flter Rudes NAT Mongle Raw Service Pots Connections Addwess Lists Layer7 Protocols
+ ) 4
Name Regerp
© block. * vigoogle com)"$
o +facebook com) '$
2tems
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Figure 3.3.8.1: Block IP configure and create rule

O Step 2:

[] [ safe Mode

& Guick Set
1 CAPsMAN

| Interfaces

L Wireless

4 Brcge

=% PPP

== Switch

“13 Mesh

40P I
" MPLS I
# Routng f
i System )
& Queves

] Files

|2] Log

8. Radus

X Tools f
B New Teminal
= cp

#4 MetaROLITER
#5 Paition

| 4 Make Supout i
@ Manual

@ New WinBox

Eea

O Step 3:

A Quick Set
1 CAPsMAN
| Interfaces
3 Wireless
gﬁ Bridge
=8 PPP

= Switch
°15 Mesh

g P

<’ MPLS
42 Routing
g System
’ Queues
(| Files

] Log

. Radius

A Tools I

] New Terminal
= cD

=4 MetaROUTER
@5 Parition

| & Make Supout rif
& Manual

£ M WinDnw

Session: D4 CA60:86C0.00] L]
New Frewal Rule []
|+ =| »|%|a| 7 General | Advanced | Eia | Action Satistics ]
| Address Network Interfac| - - = -
17250101724 17250100 saddan ey S cred ]
192.168.50.24/24 192.168.500  ethe2 S Address: 1[17250.100/24 |~ E
Dat. Address: -
Protocol: -
Src. Port -
Fiter Rules | NAT Mangle Raw Service Fots Conned Dst Pot -
#|[=] [~][z] [@] [¥] [00 Reset Courters Ny v -
[#L [Src. Address fon i
A In. Interface: o
3 X 7250.10 Out Intedace: - 8
4 X a 11
5 X 172.50.10.0 . N ] |
6 17250.10.0/24 br; beciface Lt ks
Out Interface List: v
Packet Mark: | g
Connection Mark: N
- RotingMarkk: ¥ | —
+l —% 0]
[7ems Routing Table:
Connection Type: w
Connection State: 7 v
Connection NAT State: v
Figure 3.3.8.2: IP source configure, drop and forward
5][%]
*|=| [v]x| (@] 7| P ]
7 [Network [Interface =
17250.100  saddam
%°192.168.50.24/24 192168500  ether?
Firewall [=] E3
Fiter Rules NAT Mangle Raw Service Pots Connections Address Lists Layer7 Protocols \
| [=] [v] E
/ |Regexp | 4
” +facebook com)."$ 1
1item
Figure 3.3.8.3: Final Result of Site Block
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3.4.1 Installation of Linux CentOS 6.4:

In this session, | will show that how to install CentOS 6.4 using the ISO image file in
USB device. [']

3.4.2 CentOS 6.4 Installation Guide:

1. First we need to download the CentOS 6.4 DVD ISO image file and then create
a bootable USB stick using LiveUSB Creator called Rufus.

2. After that, boot our pc and select the bootable USB, press any key to access the
Grub boot menu, then select USB disk and click Enter to Install.

Helcome to CentOS 6.4t

=y L )
Rescue installed systen
Boot from local drive

Memory test

Press [Tabl to edit options

Automatic boot in 49 seconds...

CentOS 6

Community ENTerprise Operating System

Figure 3.4.2.1: CentOS 6 installation Welcome Screen

3. Click on Next to proceed, then choose the installation language package whatever

you wish to use, and click on Next.

© Daffodil International University 18



What language would you like to use during the
installation process?

Bulgarian (Gbarapcku)

Catalan (Catala)
Chinese(Simplified) (#737 (4#) )
Chinese(Traditional) (432 (ER) )
Croatian (Hrvatski)

Czech (Cestina)

Danish (Dansk)

Dutch (Nederlands)

Estonian (eesti keel)
Finnish (suomi)
French (Frangais)
German (Deutsch)
Greek (EAAnwK@)
Gujarati (pvicll)

4aBack

Figure 3.4.2.2: Language pack for Setup

4. Select the appropriate keyboard layout you wish to use such as “U.S. English” and

click on Next and select the storage devices and click Next to install process.

[, Select the appropriate keyboard for
g the system

Portuguese
Romanian

Siovak (qwerty]
Siavenian
Spanish

Swedis

Swiss German (latin1)
Turki

United Kingdom

m Back

What type of devices will your installation involve?

a1 types of storage devices. It you're not sure which opBion s right for you.
this is probably &t

Specialized Storage Devices

uch as Storage Ares Networks (SANS) This option wit aliow

. uogr ades to enterpri
you 1o add FCOE | 5CS / 2FCP o 0 Miter out devices the matalier should gnore

4 Back

Figure 3.4.2.3: Keyboard Type and Storage Selection

5. In storage device warning, select the option to clear data on the storage disk by

selecting Yes, discard any data and click Next. Now set the Hostname and click Next.

A The storage device below may contain data.

VMware, VMware Virtual S
W 2048000MB  pci-0000:00:10.0-5¢si-0:0:0:0

We could not detect partitions or filesystems on this device.
This could be because the device is blank. unpartitioned,
or virtual. If not, there may be data on the device that can
not be recovered if you use it in this installation. We can

remove the device from this installation to protect the data

Are you sure this device does not contain valuable data?
¥ Apply my choice to all devices with undetected partitions or filesystems.

a | [ Mo, keep any data

4 Back

gy Please name this computer. The
% hostname identifies the computer on a
network

Hostname:

Configure Network

gack
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6. Set the Time zone for your location and click Next to proceed, then set the root user
password and confirm it and click on Next.

Please select the nearest city in your time zone: The root account fs used for administering
x 5 the system. Enter a password for the root
user

Root Password:

Confirm:
Selected city: Dhaka, Asia

L3
¥ System clock uses UTC
dmgack 4 Back

Figure 3.4.2.4: Time Zone Selection

7. Now, you need to choose which type of installation you want to install. Now flow the

instruction step by step for partition all drive.

Step 1:

Which type of installation would you like?
Please Select A Device
Device
(M8) | RA (Create Partition
> Hard Drives
= sda
Free 204797 Create Software RAID Information
RAID Partition
Create LVWM Information
Stom layout on the seiected device(s) using our partioning tool
LVM Physical Volume
cancel
1S
Create Reset
4 Back duBack =) Next

© Daffodil International University 20



[Mount Point:

Qedice File System Type: |

Add Partition

< Hard Drives
v sda
Free
Allowable Drives:

Size (MB):
Additional Size Options
e

Fill all space up to (MB):

Encrypt

Fill to maximum allowable size

Force to be a primary partition

Cancel

@ Back

Reset

| wp Next

Figure 3.4.2.5: Partition layout Selection

Step 2:

Please Select A Device DLo AD
Add Partition
[Mount Point:
Size Create Storage
Device : Device -
8) Create Partition File System Type: s
v Hard Drives standard Partition v Hard Drives
© sda < sda
sdal 200 /b Create Software RAID Information sdal bt
Free 204599 RAID Partition Hae (Allowable Drives:
Create LVM Information size (MB): s
Additional Size Options
Fixed size
Fill all space up to (MB)
Force to be a primary partition
Cancel P
~] Encrypt
Create Reset Cancel Reset
&
4uBack ) Next 4uBack = Next
Please Select A Device Make LVM Volume Group
yolume Group Name: va
Device 15:;) o Create Storage Device  |Physical Extert: e g
Create Partition
~ Hard Drives Standard Partition 4 sda2 20499600 MB
v sda
sdal 200 /bq Create Software RAID Information Volumes to Use
sda2 204599 RAID Partition
Used Space: 0.00MB (0.0%
Reserved Space:
Free SpAC 596.0 100.0 %
Create LVM Information ';f:az:‘x'; ﬁw . ; :‘u‘ o
© (LVM Volume Group Logical Volumes
Logical Volume Name Mount Point  Size (M8)
add
LVM Physical Volume B
£
Delete
Cancel Create
3
Create Reset Regel
Cance
& Back ) Next mack o Next
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Step 4:

LVM Volume Group VG (204596 MB)

LVM Volume Group VG (204596 MB)

Edit LVM Volume Group: VG

rree
204596 M8
Volume Group Name: VG
sig] ,
Device Device physical : 4 M Z
(M Create Partition EyScal Exter jame
< LVM Volume Groups Standard Partition ~ VM Volume G ) sda2  204596.00 MB
. Make Logical Volume [—
= 2049 Create Software RAID Information Free |Physical Volu . ‘
v Hard Drives BAID Partition s Hard Drives [Mount Point: )
- md ; v saad Used space: _|Eile System Type: | swap
sda sdal | Reserved Spac
jical Vol : 10 ]
sda2 2049 Create LYM Information sdaz  |Fiee Space: | LOCICAINOUE Ne e § TGVDION
e oo ]
Logical Volug
(] Encrypt (Max size is 204596 MB)
® {LvM Logical Volume VG o Logical Voluf -
x [Ccancet ][ ok [ add
LVM Physical Volume [ gar
| Delete
Cancel Create —
Create Edit Delete Reset Reset
Cancel |[ ok | ——
4 Back ) Next | qmBack | | spnex |

Step 5:

Please Select A Device

Mount Point/

Device f‘::é it dieic] Type Format
= LVM Volume Groups
v Ve 204596
LogVolol 100000 / extd v
LogVol0o 2048 swap v
LogVol02 102548 /home extd v
< Hard Drives
< sda
sdal 200 /boot extd
sda2 204599 VG physical volume (LVM) v/
3

Create |

Reset

4aBack y ) Next J

Please Select A Device

Format Warnings
The foliowing pre-existing devices have been selected to be

formatted, destroying all data.
partition table (MSDOS)

Device

jdev/sda

LogVolol

LogVol0o

Logvoloz
© Hard Drives

< sda
sdal
sda2

Eormat
S

Cancel

Create

4mBack

Reset

w Next

13. Then Click Write changes to disk and then click Next to proceed and now, select

the installer to install the boot loader, then click Next to start installation process of files.

Please Select A Device

Size Mount Point/

Device f B ONolume TYPe Format

Writing storage configuration to disk

The partitioning options you have selected
will now be written to disk. Any data on
deleted or reformatted partitions will be lost

Create

& Back w Next

! Install boot loader on /dev/sda. | Change device

Use a boot loader password

Boot loader operating system list
Default Label
. CentOS /dev/mapper/VG-Logvol0l

Device

Installation Progress

Retrieving installation information for CentOS.

e Back

Edit
Delete

e
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15. For GUI Select Desktop and then click Next to proceed and wait for until complete
the installation.

The default installation of CentOS is a minimum install. You can optionally selecta
different set of software now.

Basic Server J

Database Server €n

Web Server Commnity ENTrpviss Operating Sustem
Please select any additional repositories that you want to use for software installation
¥ CentOS

“pleted: 621 of 1069

Installing farsight2-0.0.16-1.1.¢16.x86_64 (484 K8)
Ubraries for videoconferencing

4 Add additional software repositories  Modify repository

You can further customize the software selection now, or after install via the software

management application.

® Customize later Customize now

L3
4 Back » next

17. After rebooting and starting all services, you will land at the Welcome screen,

click on Forward to continue. Now, agree to the CentOS License Agreement and
click on Forward.

Welcome

Thece e a faw more seps to

Plesse clck the "Forwar

License Information

CentOS6 &

Figure 3.4.2.6: CentOS License Agreement
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18. Now create an additional user, enter the username, full name and set for it a
password and confirm the password and click Forward to proceed. Next, set the Date
and Time for your system. It is recommending to synchronize data and time over

network. Once you are done, click Forward.

Create User Date and Time

Figure 3.4.2.7: CentOS User Create, Date and time setting

19. Finally, log into new CentOS 6.4 system as shown. Use your Username and

Password to log in. [¢]

Figure 3.4.2.8: CentOS User Login and Welcome Screen

3.4.3 Introduction to Linux Kernel and Shell:

Kernel:

The kernel is a computer program that is use for the core of a computer’s operating
system, with complete control over everything in the system. The manages resources

of the Linux system is—

= Process management.

= Memory management.
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e |/O management.
e File management.
e Device management etc.

Shell:

A shell is special user program which based on interface to user to use operating system
services. Shell program accept human readable commands from user and convert them
into something which kernel can understand. It is a command language interpreter that
execute commands read from input devices such as from files or keyboards. The shell
started when the user log in or start the terminal program. [

Shell is broadly classified into two categories —

e Command Line Shell
e Graphical shell

> overide@Atul-HP: ~

overide@Atul-HP

~

¢ > AHome Desktop gfg docs

© Recent =
A Home — ¢ ¢

docs knearest.py longest_even_
W Desktop length_sum.py
B Documents
¥ Downloads @ e
71 Music max_loot.py min_offerings.py pattern.py
M Pictures a a
W Videos quick_hull.py sumtree.py
@ Trash

Figure 3.4.3.1: Command Line Shell and Graphic Shell
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3.4.4 How to break Root password in Linux OS:
In VMware we have to do at first
press ctrl alt delete or restart the system >space press > e >kernel /vmlinuz
select>e>space 1>enter >b>passwd>new password input>retype password>

init 6>login root user with new password then apply.

O Step 1:

GNU GRUB version B.97 (636K louer / 3143552K upper memory)

Cent0S (2.6.32-358.el6. kB6_64)

Use the t and | keys to select which entry is highlighted.
Press enter to boot th ected 05, 'e’ to edit the
commands before booting, 'a’ to modify the kernel arguments
before booting, or 'c” for a command-line.

Figure 3.4.4.1: Press space to select centos version mode

O Step 2:

GNU GRUB wversion 8.97 (636R lower / 3143552K upper memory)

root (hdd,8)
kernel sumlinuz-2.6.32-358.e16.x86_64 ro root=UUID=915f1361-c4f3-4b8e~»
initrd 7Zinitramfs-2.6.32-358.e16.%86_64. ing

Use the t and { keys to select which entry is highlighted.
Press 'b’ to boot, ’e’ to edit the selected command in the
boot sequence, ’'c’ for a command-line, ‘o’ to open a new line
after ('0’ for before) the selected line, 'd’ to remove the
selected line, or escape to go back to the main menu.

Figure 3.4.4.2: Select Kernel mode
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Telling INIT to go to single user mode.

init: rc main process (1229) killed by TERM signal
[rootPlocalhost ~/1# root

bash: root: command not found

[root@localhost /1# passwd

Changing password for user root.

New password:

BAD PASSWORD: it does not contain enough DIFFERENT characters
BAD PASSWORD: is too simple

Retype mew password:

passwd: all authentication tokens updated successfully.
[root@localhost ~1# _

Figure 3.4.4.3: Password Configuration
3.4.5 Static IP Routing Configuration with Linux:

For Static IP routing, at first configure IP Address, Network and Gate Way By #
vim ifcfg-eth0 and follow my image instruction. 2%

O Step 1:

willson®localhostetc/sysconfig/network-scripts

Ble Edt Yiew Search Terminal Help

[root@localhost ~]# cd /etc/sysconfig/network-scripts/

[root@localhost network-scripts]# 1s

ifcfg-etho isdn

ifcfg-lo
network-functions
network-functions-ipv6

[root@localhost network-scripts]# vim ifcfg-ethOl

willson@localhost:/etc/sysconfig/network-scripts

File Edit View Search Terminal Help

DEVICE=etho

HWADDR=00:0C:29:D1:AC:1F

TYPE=Ethernet
UUID=fdf57d75-46e8-491c-9328-798e5a91b6h4
ONBOOT=yes

NM CONTROLLED=yes

BOOTPROTO=static

IPADDR=192.168.50.35
NETMASK=255.255.255.0

GATWAY=192.168.50.1

Figure 3.4.5.1: IP Configuration Static
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O Step 2:

DNS server configuration by pressing # vim /etc/resolv.conf and assign DNS name
server

Ble ESt Yiew Search Jerminal Help

[root@localhost ~]# cd /etc/sysconfig/network-scripts/
[root@localhost network-scripts]# ls

ifcfg-eth® ifdown-isdn ifup-aliases ifup-plusb init.ipv6-global
ifcfg-lo ifdown-post ifup-bnep ifup-post net.hotplug

ifdown ifdown-ppp ifup-eth ifup-ppp network-functions
ifdown-bnep ifdown-routes ifup-ippp ifup-routes network-functions-ipv6
ifdown-eth ifdown-sit ifup-ipv6 ifup-sit

ifdown-ippp ifdown-tunnel ifup-isdn ifup-tunnel

ifdown-ipv6 ifup ifup-plip ifup-wireless

[root@localhost network-scripts]# vim ifcfg-eth0

[root@localhost network-scripts]# vim ifcfg-eth@

[root@localhost network-scripts]# vim /etc/sysconfig/network-scripts/ifcfg-eth®
[root@localhost network-scripts]# vim /etc/resolv.confl}

willson@localhost:/etc/sysconfig/network-scripts

File Edit View Search Jerminal Help

# Generated by NetworkManager

No nameservers found; try putting DNS servers into your
ifcfg files in /etc/sysconfig/network-scripts like so:

DNS1=XXX.XXX . XXX . XXX
DNS2=XXX . XXX . XXX . XXX
DOMAIN=1lab.foo.com bar.foo.co
nameserver 8.8.8.8

nameserver 8.8.4.4

HFHEHEHHEHR

Figure 3.4.5.2: DNS Name server Configuration

O Step 3:

file Edit Yiew Search Terminal Help

Starting NetworkManager daemon: [ 0K ]
[root@localhost network-scripts]# service NetworkManager restart
Stopping NetworkManager daemon: [ OK ]
Setting network parameters... [ 0K ]
Starting NetworkManager daemon: [ OK ]
[root@localhost network-scripts]# service NetworkManager restart
Stopping NetworkManager daemon: [ OK ]
Setting network parameters... [ OK ]
Starting NetworkManager daemon: [ 0K ]
[root@localhost network-scripts]# service NetworkManager stop
Stopping NetworkManager daemon: [ OK ]

[root@localhost network-scripts]# chkconfig NetworkManager off
[root@localhost network-scripts]#

[root@localhost network-scripts]#

[root@localhost network-scripts]#

[root@localhost network-scripts]#

[root@localhost network-scripts]# service NetworkManager status
NetworkManager is stopped

[root@localhost network-scripts]# service network restart

Shutting down interface etho: [ 0K ]
Shutting down loopback interface: [ OK 1]
Bringing up loopback interface: [ OK ]
Bringing up interface eth0: ~[ [ oK ] B

Figure 3.4.5.3: Service Network Restart
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O Step 4:

When all configuration is complete then ping the IP # ping 192.168.50.1

willson@localhost:/etc/sysconfig/network-scripts

File Edit View Search Terminal Help
Bringing up loopback interface:
Bringing up interface ethO:
[root@localhost network-scripts]# vim /etc/resolv.conf
[root@localhost network-scripts]# service network restart
Shutting down interface ethO:
Shutting down loopback interface:
Bringing up loopback interface:
Bringing up interface ethoO:
[root@localhost network-scripts]# vim /etc/resolv.conf
[root@localhost network-scripts]# vim /etc/resolv.conf
[root@localhost network-scripts]# ping 192.168.50.1

PING 192.168.50.1

64 bytes from
64 bytes from
64 bytes from
64 bytes from
64 bytes from
64 bytes from
64 bytes from
64 bytes from
64 bytes from
64 bytes from
64 bytes from

192
192,
192.
192
192.
192
192,
192.
192.
192.
192.

(192.168
168.50.
168.50.
168.50.
168.50.
168.50.
168.50.
168.50.
168.50.
168.50.
168.50.
168.50.

oo ol sl ull ol ol sl sl el ol

50.1) 56(84) bytes

1cmp seq=1
icmp seq=2
icmp seqg=3
icmp seq=4
icmp_seq=5
icmp seq=6
icmp_seq=7
icmp seq=8
1cmp seq=9

ttl=64
tt1=64
tt1=64
tt1=64
tt1=64
tt1=64
tt1=64
tt1=64
tt1=64

————
(o =]
A X

[

of data.

time=19.2 ms
time=1.62 ms
time=0.978 ms
time=1.79 ms
time=2.91 ms
time=2.98 ms
time=2.25 ms
time=1.34 ms
time=2.04 ms

1cmp seq=10 ttl=64 time=0.925 ms
icmp seq=11 ttl=64 time=2.93 ms

Figure 3.4.5.4: IP Ping of Static Routing
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CHAPTER 4

Conclusion and Future Career &
Scope

4.1 Conclusion and Discussion:

In short of my internship project I will learn about configuring network by MikroTik
and Linux platform and how to make and configure network. I will also learn and
complete understanding about IP Classes. Main learning of this project was how to
configure ISP link, bandwidth Control in different ways, bridge mode configuration,
Firewall and NAT Configuration, Network Security, Linux installation, Run level of
Linux, Linux server administration. All of the instruction helps and improved me to
increase build my job aims and career skillful. That’s why now I can create ISP based
setup and administration on the Linux platform and provide entry-level work and
support. This project is completely hand course and provides information and aptitudes
which will introduce me to a Linux server for informative, informative and basic system
administration. Along with improving the most recent forms and server security, we
always see the reconstruction and role of the programming department. The MikroTik
and Linux operating system provide us a comprehensive introduction of steady, reliable
and successful administration. The Linux system provide us almost all system
administrators, Web server pioneer, SS, Telnet, DNS, FTP, mail server and so one.
Now, today most of the organizations are highly dependent on their work on the network
thought Internet. Therefor a proper network design is very important think of an

organization, without this it is not possible to manage all network support.

4.2 Future Career & Scope:
In real life finding a job can be a big challenge of anyone of our country, especially if

we have no experience. That’s why I choose internship, because it can help me to
improve my career opportunity into an experience. So, this internship provides me to

find scope in future life:

» Work in ISP based platform.
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[1]

[2]

[3]

[4]

» Work at as an IT manager of a company.
» Work at as a Network Engineer.
» Work at as a technical support and security manager.
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